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Supplementary Figures 

Figure 1: Tukey’s post hoc test, CL species 
 
(a) Contusional Cortex 

 

 
 
(b) Non-contusional Cortex 

 
 
 
(c) Hippocampus 

 
  

CL(74:7) CL(76:11) CL(74:9) CL(74:8) CL(76:10) CL(74:6) CL(76:12) CL(72:5) CL(72:7) CL(74:10) CL(72:6) CL(76:9) CL(72:4) CL(72:8) CL(72:9) CL(74:11) CL(70:5) CL(70:7) CL(70:4) CL(70:6) CL(72:3) CL(76:8) CL(70:3)

CL(74:7) 1.000 1.000 1.000 1.000 1.000 0.968 0.951 0.926 0.915 0.870 0.471 0.267 0.041 0.013 0.010 0.008 0.006 0.005 0.002 0.001 0.001 0.000

CL(76:11) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.999 0.997 0.883 0.692 0.199 0.079 0.060 0.052 0.037 0.032 0.012 0.007 0.005 0.001

CL(74:9) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.945 0.806 0.285 0.122 0.094 0.082 0.060 0.052 0.020 0.012 0.008 0.003

CL(74:8) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.970 0.866 0.351 0.159 0.124 0.109 0.081 0.070 0.028 0.017 0.011 0.004

CL(76:10) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.992 0.943 0.487 0.245 0.197 0.175 0.134 0.117 0.049 0.030 0.020 0.007

CL(74:6) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.994 0.948 0.502 0.255 0.206 0.183 0.140 0.122 0.052 0.032 0.022 0.008

CL(76:12) 0.968 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.884 0.647 0.571 0.531 0.447 0.408 0.218 0.149 0.107 0.044

CL(72:5) 0.951 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.915 0.702 0.628 0.588 0.502 0.462 0.256 0.177 0.130 0.054

CL(72:7) 0.926 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.943 0.760 0.690 0.651 0.565 0.524 0.303 0.214 0.158 0.068

CL(74:10) 0.915 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.951 0.779 0.711 0.673 0.587 0.546 0.320 0.228 0.169 0.074

CL(72:6) 0.870 0.997 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.973 0.842 0.782 0.747 0.666 0.625 0.388 0.283 0.215 0.097

CL(76:9) 0.471 0.883 0.945 0.970 0.992 0.994 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.994 0.986 0.981 0.961 0.947 0.806 0.693 0.594 0.355

CL(72:4) 0.267 0.692 0.806 0.866 0.943 0.948 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.999 0.996 0.993 0.945 0.884 0.814 0.581

CL(72:8) 0.041 0.199 0.285 0.351 0.487 0.502 0.884 0.915 0.943 0.951 0.973 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.971

CL(72:9) 0.013 0.079 0.122 0.159 0.245 0.255 0.647 0.702 0.760 0.779 0.842 0.994 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999

CL(74:11) 0.010 0.060 0.094 0.124 0.197 0.206 0.571 0.628 0.690 0.711 0.782 0.986 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
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CL(70:4) 0.005 0.032 0.052 0.070 0.117 0.122 0.408 0.462 0.524 0.546 0.625 0.947 0.993 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(70:6) 0.002 0.012 0.020 0.028 0.049 0.052 0.218 0.256 0.303 0.320 0.388 0.806 0.945 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:3) 0.001 0.007 0.012 0.017 0.030 0.032 0.149 0.177 0.214 0.228 0.283 0.693 0.884 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(76:8) 0.001 0.005 0.008 0.011 0.020 0.022 0.107 0.130 0.158 0.169 0.215 0.594 0.814 0.998 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(70:3) 0.000 0.001 0.003 0.004 0.007 0.008 0.044 0.054 0.068 0.074 0.097 0.355 0.581 0.971 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(76:8) CL(72:3) CL(76:11) CL(76:9) CL(70:7) CL(74:11) CL(72:9) CL(70:5) CL(70:3) CL(74:10) CL(70:6) CL(76:12) CL(76:10) CL(70:4) CL(74:9) CL(74:8) CL(72:4) CL(72:7) CL(72:6) CL(74:6) CL(72:5) CL(74:7) CL(72:8)

CL(76:8) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.985 0.927 0.769

CL(72:3) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.990 0.942 0.798

CL(76:11) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.996 0.971 0.867

CL(76:9) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.985 0.914

CL(70:7) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.990 0.933

CL(74:11) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.994 0.949

CL(72:9) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.994 0.950

CL(70:5) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.997 0.965

CL(70:3) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.997 0.970

CL(74:10) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.997 0.971

CL(70:6) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.977

CL(76:12) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.977

CL(76:10) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.986

CL(70:4) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.989

CL(74:9) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998

CL(74:8) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998

CL(72:4) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:7) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:6) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(74:6) 0.998 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:5) 0.985 0.990 0.996 0.999 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(74:7) 0.927 0.942 0.971 0.985 0.990 0.994 0.994 0.997 0.997 0.997 0.998 0.998 0.999 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:8) 0.769 0.798 0.867 0.914 0.933 0.949 0.950 0.965 0.970 0.971 0.977 0.977 0.986 0.989 0.998 0.998 1.000 1.000 1.000 1.000 1.000 1.000

CL(74:7) CL(76:11) CL(74:8) CL(76:10) CL(74:9) CL(74:6) CL(76:9) CL(72:7) CL(72:5) CL(72:6) CL(76:12) CL(72:4) CL(74:10) CL(70:4) CL(76:8) CL(70:5) CL(70:3) CL(72:3) CL(70:6) CL(70:7) CL(72:8) CL(72:9) CL(74:11)

CL(74:7) 1.000 0.999 0.987 0.983 0.935 0.388 0.297 0.167 0.105 0.041 0.019 0.015 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000

CL(76:11) 1.000 1.000 1.000 1.000 1.000 0.946 0.896 0.744 0.606 0.358 0.212 0.175 0.001 0.001 0.001 0.000 0.000 0.000 0.000 0.000 0.000 0.000

CL(74:8) 0.999 1.000 1.000 1.000 1.000 0.992 0.978 0.908 0.814 0.573 0.384 0.327 0.003 0.002 0.002 0.001 0.001 0.000 0.000 0.000 0.000 0.000

CL(76:10) 0.987 1.000 1.000 1.000 1.000 1.000 0.999 0.986 0.954 0.807 0.628 0.562 0.008 0.008 0.007 0.003 0.003 0.001 0.001 0.001 0.000 0.000

CL(74:9) 0.983 1.000 1.000 1.000 1.000 1.000 0.999 0.990 0.963 0.832 0.660 0.595 0.009 0.009 0.008 0.004 0.003 0.001 0.001 0.001 0.000 0.000

CL(74:6) 0.935 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.993 0.935 0.817 0.762 0.019 0.018 0.017 0.008 0.006 0.003 0.003 0.002 0.000 0.000

CL(76:9) 0.388 0.946 0.992 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.998 0.197 0.186 0.180 0.100 0.082 0.045 0.040 0.025 0.004 0.000

CL(72:7) 0.297 0.896 0.978 0.999 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.268 0.254 0.247 0.143 0.119 0.067 0.059 0.038 0.007 0.000

CL(72:5) 0.167 0.744 0.908 0.986 0.990 0.999 1.000 1.000 1.000 1.000 1.000 1.000 0.439 0.421 0.411 0.261 0.223 0.135 0.120 0.080 0.016 0.001

CL(72:6) 0.105 0.606 0.814 0.954 0.963 0.993 1.000 1.000 1.000 1.000 1.000 1.000 0.580 0.561 0.550 0.375 0.327 0.209 0.189 0.129 0.029 0.001

CL(76:12) 0.041 0.358 0.573 0.807 0.832 0.935 1.000 1.000 1.000 1.000 1.000 1.000 0.820 0.804 0.796 0.627 0.570 0.410 0.378 0.278 0.076 0.004

CL(72:4) 0.019 0.212 0.384 0.628 0.660 0.817 0.999 1.000 1.000 1.000 1.000 1.000 0.936 0.928 0.923 0.806 0.758 0.601 0.566 0.446 0.146 0.009

CL(74:10) 0.015 0.175 0.327 0.562 0.595 0.762 0.998 1.000 1.000 1.000 1.000 1.000 0.959 0.953 0.950 0.855 0.814 0.667 0.632 0.510 0.179 0.011

CL(70:4) 0.000 0.001 0.003 0.008 0.009 0.019 0.197 0.268 0.439 0.580 0.820 0.936 0.959 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.641

CL(76:8) 0.000 0.001 0.002 0.008 0.009 0.018 0.186 0.254 0.421 0.561 0.804 0.928 0.953 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.660

CL(70:5) 0.000 0.001 0.002 0.007 0.008 0.017 0.180 0.247 0.411 0.550 0.796 0.923 0.950 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.670

CL(70:3) 0.000 0.000 0.001 0.003 0.004 0.008 0.100 0.143 0.261 0.375 0.627 0.806 0.855 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.830

CL(72:3) 0.000 0.000 0.001 0.003 0.003 0.006 0.082 0.119 0.223 0.327 0.570 0.758 0.814 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.870

CL(70:6) 0.000 0.000 0.000 0.001 0.001 0.003 0.045 0.067 0.135 0.209 0.410 0.601 0.667 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.951

CL(70:7) 0.000 0.000 0.000 0.001 0.001 0.003 0.040 0.059 0.120 0.189 0.378 0.566 0.632 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.962

CL(72:8) 0.000 0.000 0.000 0.001 0.001 0.002 0.025 0.038 0.080 0.129 0.278 0.446 0.510 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.986

CL(72:9) 0.000 0.000 0.000 0.000 0.000 0.000 0.004 0.007 0.016 0.029 0.076 0.146 0.179 0.998 0.998 0.998 1.000 1.000 1.000 1.000 1.000 1.000

CL(74:11) 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.001 0.001 0.004 0.009 0.011 0.641 0.660 0.670 0.830 0.870 0.951 0.962 0.986 1.000



 

 
(d) Thalamus 

 
 
 

Fig. 1: Statistically significant differences between ipsi-/contralateral ratios of different CL 

species in various CCI brain regions. Tukey’s post hoc test was performed by treating the ipsi-

/contralateral ratios of each CL species as a group within each of the following regions: the 

contusional cortex (a), an adjacent non-contusional cortical area (b), the hippocampus (c) and 

thalamus (d). CL species are arranged within the tables in the same order as described in Figure 

3 (i.e. the CL species exhibiting the most loss ipsi-/contralaterally on the left/top and proceeding 

to those that lost the least on the right/bottom). The cells give the p-value between two CL species, 

and p-values < 0.050 are highlighted in red. For example, in the contusional cortex (a) the ipsi-

/contralateral ratios of CL(74:7) are not significantly different from those of CL(76:11) but are 

significantly different from CL(70:3). 
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CL(76:10) 1.000 1.000 1.000 1.000 1.000 0.986 0.979 0.782 0.502 0.485 0.421 0.286 0.171 0.137 0.122 0.105 0.072 0.055 0.044 0.037 0.004 0.002

CL(74:8) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.963 0.805 0.792 0.733 0.577 0.404 0.342 0.311 0.276 0.204 0.163 0.135 0.115 0.016 0.009

CL(76:12) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.987 0.890 0.880 0.835 0.697 0.520 0.451 0.416 0.375 0.286 0.233 0.197 0.170 0.026 0.015

CL(74:10) 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.993 0.926 0.918 0.882 0.761 0.590 0.519 0.482 0.439 0.342 0.282 0.240 0.210 0.034 0.021

CL(74:9) 0.996 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.994 0.993 0.986 0.948 0.855 0.802 0.771 0.730 0.626 0.551 0.492 0.446 0.101 0.064

CL(74:7) 0.908 0.986 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.989 0.978 0.970 0.958 0.914 0.872 0.831 0.793 0.300 0.211

CL(76:9) 0.885 0.979 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.993 0.985 0.979 0.969 0.933 0.897 0.860 0.826 0.333 0.238

CL(72:6) 0.543 0.782 0.963 0.987 0.993 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998 0.996 0.992 0.987 0.708 0.582

CL(72:7) 0.281 0.502 0.805 0.890 0.926 0.994 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.921 0.845

CL(72:5) 0.269 0.485 0.792 0.880 0.918 0.993 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.929 0.856

CL(72:8) 0.223 0.421 0.733 0.835 0.882 0.986 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.954 0.898

CL(72:4) 0.137 0.286 0.577 0.697 0.761 0.948 0.999 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.988 0.964

CL(74:6) 0.075 0.171 0.404 0.520 0.590 0.855 0.989 0.993 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.993

CL(70:3) 0.058 0.137 0.342 0.451 0.519 0.802 0.978 0.985 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999 0.997

CL(70:4) 0.051 0.122 0.311 0.416 0.482 0.771 0.970 0.979 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.998

CL(74:11) 0.043 0.105 0.276 0.375 0.439 0.730 0.958 0.969 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 0.999

CL(76:8) 0.028 0.072 0.204 0.286 0.342 0.626 0.914 0.933 0.998 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(70:6) 0.021 0.055 0.163 0.233 0.282 0.551 0.872 0.897 0.996 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:9) 0.016 0.044 0.135 0.197 0.240 0.492 0.831 0.860 0.992 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(70:5) 0.013 0.037 0.115 0.170 0.210 0.446 0.793 0.826 0.987 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(72:3) 0.001 0.004 0.016 0.026 0.034 0.101 0.300 0.333 0.708 0.921 0.929 0.954 0.988 0.999 0.999 1.000 1.000 1.000 1.000 1.000 1.000 1.000

CL(70:7) 0.001 0.002 0.009 0.015 0.021 0.064 0.211 0.238 0.582 0.845 0.856 0.898 0.964 0.993 0.997 0.998 0.999 1.000 1.000 1.000 1.000 1.000



 

 

Fig. 2:  MALDI-MS images of the major ganglioside species from rat brain tissue.  IMS 

negative ion mode heat maps of the major PI and sulfatide species in naïve and CCI-TBI rat brain 

tissue sections treated with EDC-PLC (representative images from 3 animals). A corresponding 

H&E optical image (scale bar = 1 mm) is shown for both naïve and CCI-TBI tissue. Ganglioside 

species include GM1 (18:0), m/z 1544.9; GM1 (20:0), m/z 1572.9; GD1 (18:0)-H2O, m/z 1818.0 

and GD1 (20:0)-H2O, m/z 1846.0. Arrow indicates the point of impact on the CCI tissue. MALDI-

MS images are displayed as relative intensities. 

  



 

 

 

Fig. 3: Ratiometric images of CL in naïve rat brain tissue. 

Ratiometric analysis of CL-IMS intensity to mitochondrial immunofluorescence intensity was 

assessed. Rat brain coronal sections (right hemispheres) were prepared for CL-IMS and CL heat 

maps were generated. Semi-serial brain sections were also prepared for mitochondrial 

immunohistochemical (IHC) staining using a fluorescent-labeled TOM 20 antibody. Ratiometric 

images for individual CL species are presented.  MS image intensities for 23 individual CL species 

were rendered to a 12 bit range and ratioed with the mitochondrial IHC image and displayed as 

monochrome heat maps on a scale from 0 (black, less CL relative to mitochondria) to 50 (white, 

more CL relative to mitochondria). Ratiometric images of CL from clusters 70:X, 72:X , 74:X and 

76:X are presented. In addition, an optical IHC H&E image (scale bar = 1 mm) and a TOM 20 IHC 

image are also shown.   



 

 

 

 

Fig. 4: Ratiometric images of CL in CCI rat brain tissue. 

Ratiometric analysis of CL-IMS intensity to mitochondrial immunofluorescence intensity was 

assessed. CCI rat brain coronal sections were prepared for CL-IMS and CL heat maps were 

generated. Semi-serial brain sections were also prepared for mitochondrial immunohistochemical 

(IHC) staining using a fluorescent-labeled TOM 20 antibody. Ratiometric images for individual CL 

species are presented.  MS image intensities for 23 individual CL species were rendered to a 12 

bit range and ratioed with the mitochondrial IHC image and displayed as monochrome heat maps 

on a scale from 0 (black, less CL relative to mitochondria) to 50 (white, more CL relative to 

mitochondria). Ratiometric images of CL from clusters 70:X, 72:X , 74:X and 76:X are presented. 

In addition, an optical IHC H&E image (scale bar = 1 mm) and a TOM 20 IHC image are also 

shown. 

  



 

Supplementary Tables 

 

Table 1: CL species identified in rat brain based on MS/MS fragmentation as determined 

from LC-MS analysis. 

Acyl 
Carbons: 
Double 
bonds 

No PUFA One PUFA Two PUFA Three PUFA Four PUFA 

70:10   C16:1C16:2C18:1C20:6 C16:1C16:1C18:2C20:6   C16:2C16:2C18:2C20:4 

70:8 

  C14:0C16:1C18:1C22:6 C14:0C16:0C18:2C22:6 C14:0C18:2C18:2C20:4   

  C16:0C16:1C16:1C22:6 C14:0C16:0C20:4C20:4     

    C16:1C16:1C18:2C20:4     

70:7 
  C16:1C16:1C18:1C20:4 C14:0C18:1C18:2C20:4 C16:1C18:2C18:2C18:2   

    C16:0C16:1C18:2C20:4     

70:6 
  C16:0C16:1C18:1C20:4 C16:1C18:1C18:2C18:2 C16:0C18:2C18:2C18:2   

  C14:0C18:1C18:1C20:4 C16:0C16:0C18:2C20:4     

70:5 

C16:1C16:1C18:2C20:1 C16:0C16:1C18:1C20:3 C16:0C16:0C18:2C20:3     

  C16:1C18:1C18:1C18:2 C16:0C18:1C18:2C18:2     

  C14:0C16:1C20:3C20:1 C14:0C18:2C18:2C20:1     

  C16:0C16:0C18:1C20:4       

  C14:0C16:0C20:4C20:1       

  C14:0C18:1C18:1C20:3       

70:4 

C16:1C18:1C18:1C18:1 C16:1C18:0C18:1C18:2 C16:0C18:0C18:2C18:2     

  C16:0C18:1C18:1C18:2       

  C14:0C18:0C18:0C20:4       

  C16:0C16:0C18:0C20:4       

70:3 C16:0C18:1C18:1C18:1         

70:2 
C16:1C18:0C18:0C18:1         

C16:0C18:0C18:1C18:1         

72:10 
    C16:1C16:1C18:2C22:6     

    C16:1C16:1C20:4C20:4     

72:9 

  C16:1C16:1C18:1C22:6 C14:0C16:0C20:3C22:6     

    C14:0C18:1C18:2C22:6 C14:0C18:2C20:4C20:3   

    C14:0C18:1C20:4C20:4 C16:1C18:2C18:2C20:4   

    C16:1C16:1C20:4C20:3     

    C16:0C16:1C18:2C22:6     

    C16:0C16:1C20:4C20:4     

72:8 

  C16:0C16:1C18:1C22:6 C16:1C18:1C18:2C20:4 C16:0C18:2C18:2C20:4 C18:2C18:2C18:2C18:2 

  C14:0C18:1C18:1C22:6 C16:0C16:0C18:2C22:6     

    C16:0C16:0C20:4C20:4     

72:7   C16:1C18:1C18:1C20:4 C16:0C16:1C20:3C20:3 C16:0C18:2C18:2C20:3   



 

    C16:1C18:1C18:2C20:3 C18:1C18:2C18:2C18:2   

    C16:1C18:0C18:2C20:4     

    C16:0C16:0C20:4C20:3     

    C16:0C18:1C18:2C20:4     

    C14:0C18:1C20:3C20:3     

    C14:0C18:0C20:4C20:3     

72:6 

  C16:1C18:1C18:1C20:3 C16:1C18:0C18:2C20:3 C18:0C18:2C18:2C18:2   

  C16:1C18:0C18:1C20:4 C18:1C18:1C18:2C18:2     

  C16:0C18:1C18:1C20:4 C16:0C18:1C18:2C20:3     

    C16:0C18:0C18:2C20:4     

    C16:0C16:0C20:3C20:3     

72:5 

  C16:1C18:0C18:0C20:4 C18:0C18:1C18:2C18:2     

  C18:1C18:1C18:1C18:2       

  C16:0C18:0C18:1C20:4       

72:4 

C18:1C18:1C18:1C18:1 C18:0C18:1C18:1C18:2 C18:0C18:0C18:2C18:2     

  C16:0C16:0C18:2C22:2       

  C16:0C18:0C18:0C20:4       

72:3 C18:0C18:1C18:1C18:1         

72:2 C18:0C18:0C18:1C18:1 C18:0C18:0C18:0C18:2       

74:11 

    C16:1C16:1C20:4C22:5 C16:1C18:2C18:2C22:6   

    C16:1C16:1C20:3C22:6 C16:1C18:2C20:4C20:4   

    C14:0C16:1C22:5C22:5 C14:0C18:2C20:4C22:5   

    C14:0C20:4C20:4C20:3 C14:0C18:2C20:3C22:6   

    C14:0C18:1C20:4C22:6     

74:10 

    C16:1C18:1C18:2C22:6 C16:1C18:2C20:4C20:3 C18:2C18:2C18:2C20:4 

    C16:1C18:1C20:4C20:4 C16:0C16:1C20:3C22:6   

    C16:0C16:0C20:4C22:6 C16:0C18:2C18:2C22:6   

      C16:0C18:2C20:4C20:4   

74:9 

  C16:1C18:1C18:1C22:6 C16:1C18:1C20:4C20:3 C16:1C18:2C20:3C20:3 C18:2C18:2C18:2C20:3 

  C18:1C18:1C18:1C20:4 C16:0C18:1C18:2C22:6 C18:1C18:2C18:2C20:4   

    C16:0C18:1C20:4C20:4 C16:0C18:2C20:4C20:3   

    C16:0C16:0C20:3C22:6     

74:8     C18:1C18:1C18:2C20:4 C16:1C18:2C20:2C20:2   

74:7 

    C16:1C18:1C20:3C20:2 C18:1C18:2C18:2C20:2   

    C16:1C18:0C20:4C20:2 C18:0C18:2C18:2C20:3   

    C16:1C18:0C20:3C20:3     

    C16:0C18:2C20:3C20:2     

    C16:0C18:1C20:4C20:2     

    C16:0C18:1C20:3C20:3     

    C16:0C18:0C20:4C20:3     



 

    C18:1C18:1C18:2C20:3     

    C18:0C18:1C18:2C20:4     

74:6 

  C16:0C18:0C18:0C22:6 C16:1C18:1C20:2C20:2 C16:0C18:2C20:2C20:2   

  C18:1C18:1C18:1C20:3 C16:1C18:0C20:3C20:2 C18:0C18:2C18:2C20:2   

  C18:0C18:1C18:1C20:4 C16:0C18:1C20:3C20:2 C18:0C18:1C18:2C20:3   

    C16:0C18:0C20:4C20:2     

    C16:0C18:0C20:3C20:3     

    C18:1C18:1C18:2C20:2     

    C18:0C18:0C18:2C20:4     

74:5 
  C18:0C18:1C18:1C20:3 C18:0C18:0C18:2C20:3     

  C18:0C18:0C18:1C20:4       

74:4 
  C18:0C18:0C18:1C20:3       

  C18:0C18:0C18:0C20:4       

76:13 
    C16:0C16:1C22:6C22:6 C16:1C18:2C20:4C22:6   

      C16:1C20:4C20:4C20:4   

76:12 
    C16:0C16:0C22:6C22:6 C16:0C20:4C20:4C20:4 C20:4C20:3C20:2C16:2 

    C16:1C18:1C20:3C22:6 C16:1C18:2C20:2C22:6 C20:3C20:3C20:3C16:2 

76:11 

    C16:1C18:0C20:4C22:6 C16:1C20:4C20:4C20:2 C18:2C18:2C20:4C20:3 

      C16:1C20:4C20:3C20:3   

      C18:1C20:2C22:6C16:2   

      C18:0C20:3C22:6C16:2   

      C18:1C18:2C18:2C22:6   

      C18:1C18:2C20:4C20:4   

76:10 

    C16:1C18:1C20:2C22:6 C16:1C20:4C20:3C20:2 C20:4C20:2C20:2C16:2 

    C16:1C18:0C20:3C22:6 C16:1C20:3C20:3C20:3 C20:3C20:3C20:2C16:2 

    C18:0C20:2C22:6C16:2 C18:0C18:2C18:2C22:6 C18:2C18:2C20:4C20:2 

    C18:1C18:1C18:2C22:6 C18:1C18:2C20:4C20:3 C18:2C18:2C20:3C20:3 

    C18:1C18:1C20:4C20:4 C18:0C18:2C20:4C20:4   

76:9 

  C18:1C18:1C18:1C22:6 C16:0C16:1C22:4C22:4 C16:0C18:2C20:3C22:4   

    C16:1C18:1C20:3C22:4 C16:0C20:3C20:3C20:3   

    C16:0C16:0C22:5C22:4 C18:1C18:2C18:2C22:4   

    C16:0C18:1C20:4C22:4 C18:1C18:2C20:3C20:3   

    C16:0C18:1C20:3C22:5     

    C18:1C18:1C18:2C22:5     

    C18:1C18:1C20:4C20:3     

76:8     C18:1C18:1C20:3C20:3 C16:1C20:2C20:2C20:2   

76:7 
    C18:1C18:2C20:2C20:2     

    C18:1C18:1C20:3C20:2     

 

 



 

Table 2: Ipsilateral/contralateral intensity ratios for various lipids species. 

 

  

Species m/z

Average CCI 

ipsilateral/ 

contralateral

Std dev CCI 

ipsilateral/ 

contralateral

Average 

naïve 

ipsilateral/ 

contralateral

Std dev naïve 

ipsilateral/ 

contralateral

p-value 

Naïve vs CCI 

(red<0.05)

ST(d18:1/18:0) 806.55 1.644 0.648 1.021 0.046 0.370

PI(38:5) 883.53 0.446 0.134 1.135 0.020 0.011

PI(38:4) 885.55 0.361 0.122 1.014 0.168 0.030

ST(d18:1/24:1) 888.62 1.198 0.283 0.991 0.124 0.505

ST(d18:1/24:0) 890.64 1.892 0.878 1.016 0.155 0.358

ST(d18:1/h24:1) 904.62 1.182 0.254 1.012 0.017 0.516

CL(70:7) 1421.95 0.781 0.031 1.069 0.097 0.034

CL(70:6) 1423.96 0.809 0.045 1.025 0.056 0.035

CL(70:5) 1425.98 0.805 0.104 0.963 0.009 0.101

CL(70:4) 1428.00 0.772 0.058 1.023 0.067 0.041

CL(70:3) 1430.01 0.785 0.053 1.044 0.051 0.024

CL(72:9) 1445.95 0.760 0.045 1.041 0.128 0.073

CL(72:8) 1447.96 0.732 0.049 1.083 0.101 0.028

CL(72:7) 1449.98 0.596 0.078 1.105 0.149 0.031

CL(72:6) 1452.00 0.606 0.077 1.100 0.111 0.020

CL(72:5) 1454.01 0.590 0.094 1.098 0.083 0.017

CL(72:4) 1456.03 0.675 0.093 1.078 0.145 0.061

CL(72:3) 1458.04 0.822 0.044 1.115 0.118 0.057

CL(74:11) 1469.95 0.598 0.055 1.104 0.079 0.007

CL(74:10) 1471.96 0.516 0.090 1.085 0.086 0.012

CL(74:9) 1473.98 0.524 0.089 1.135 0.130 0.017

CL(74:8) 1476.00 0.456 0.120 1.110 0.103 0.016

CL(74:7) 1478.01 0.456 0.120 1.020 0.065 0.004

CL(74:6) 1480.03 0.540 0.100 1.050 0.130 0.031

CL(76:12) 1495.96 0.584 0.061 1.071 0.097 0.013

CL(76:11) 1497.98 0.503 0.064 1.082 0.089 0.007

CL(76:10) 1500.00 0.539 0.070 1.096 0.105 0.012

CL(76:9) 1502.01 0.651 0.090 1.072 0.055 0.019

CL(76:8) 1504.03 0.832 0.016 1.051 0.035 0.005

GM1(18:0) 1544.87 0.970 0.452 1.264 0.244 0.561

GM1(20:0) 1572.90 0.983 0.222 1.228 0.069 0.326

GD1(18:0)-H2O 1817.95 1.022 0.564 1.301 0.211 0.639

GD1(20:0)-H2O 1835.96 0.856 0.213 1.231 0.095 0.167

Cortex-Contusional(a) 



 

  

Species m/z

Average CCI 

ipsilateral/ 

contralateral

Std dev CCI 

ipsilateral/ 

contralateral

Average 

naïve 

ipsilateral/ 

contralateral

Std dev naïve 

ipsilateral/ 

contralateral

p-value 

Naïve vs CCI 

(red<0.05)

ST(d18:1/18:0) 806.55 1.403 0.452 1.668 0.159 0.581

PI(38:5) 883.53 1.215 0.443 1.193 0.118 0.961

PI(38:4) 885.55 1.113 0.412 1.176 0.159 0.883

ST(d18:1/24:1) 888.62 1.164 0.506 1.574 0.046 0.442

ST(d18:1/24:0) 890.64 1.358 0.656 1.966 0.111 0.389

ST(d18:1/h24:1) 904.62 1.199 0.402 1.412 0.025 0.603

CL(70:7) 1421.95 1.015 0.027 1.010 0.002 0.879

CL(70:6) 1423.96 1.033 0.012 0.990 0.026 0.150

CL(70:5) 1425.98 1.042 0.004 1.036 0.096 0.940

CL(70:4) 1428.00 1.026 0.023 0.959 0.024 0.093

CL(70:3) 1430.01 1.042 0.007 0.988 0.007 0.008

CL(72:9) 1445.95 1.020 0.018 0.986 0.031 0.323

CL(72:8) 1447.96 1.185 0.117 1.030 0.012 0.244

CL(72:7) 1449.98 1.082 0.108 1.069 0.020 0.904

CL(72:6) 1452.00 1.085 0.085 1.043 0.031 0.637

CL(72:5) 1454.01 1.129 0.137 1.084 0.019 0.744

CL(72:4) 1456.03 1.076 0.074 1.050 0.015 0.728

CL(72:3) 1458.04 0.988 0.016 1.032 0.062 0.427

CL(74:11) 1469.95 1.029 0.096 1.034 0.005 0.953

CL(74:10) 1471.96 1.060 0.100 1.046 0.045 0.888

CL(74:9) 1473.98 1.062 0.111 1.060 0.016 0.982

CL(74:8) 1476.00 1.155 0.207 1.138 0.073 0.935

CL(74:7) 1478.01 1.155 0.207 1.127 0.061 0.861

CL(74:6) 1480.03 1.106 0.135 1.087 0.016 0.889

CL(76:12) 1495.96 1.033 0.050 1.001 0.011 0.546

CL(76:11) 1497.98 0.999 0.099 1.067 0.011 0.507

CL(76:10) 1500.00 1.039 0.064 1.034 0.022 0.932

CL(76:9) 1502.01 1.009 0.053 1.041 0.006 0.555

CL(76:8) 1504.03 0.983 0.028 0.996 0.031 0.733

GM1(18:0) 1544.87 1.505 0.572 1.375 0.301 0.834

GM1(20:0) 1572.90 1.382 0.265 1.328 0.429 0.901

GD1(18:0)-H2O 1817.95 1.550 0.606 1.467 0.251 0.896

GD1(20:0)-H2O 1835.96 1.131 0.115 1.133 0.136 0.990

Cortex Non-contusional(b) 



 

 

 

  

Species m/z

Average CCI 

ipsilateral/ 

contralateral

Std dev CCI 

ipsilateral/ 

contralateral

Average 

naïve 

ipsilateral/ 

contralateral

Std dev naïve 

ipsilateral/ 

contralateral

p-value 

Naïve vs CCI 

(red<0.05)

ST(d18:1/18:0) 806.55 1.203 0.230 1.051 0.153 0.568

PI(38:5) 883.53 0.830 0.081 1.054 0.064 0.085

PI(38:4) 885.55 0.725 0.090 0.963 0.128 0.157

ST(d18:1/24:1) 888.62 0.936 0.115 1.014 0.143 0.641

ST(d18:1/24:0) 890.64 1.261 0.363 1.109 0.269 0.722

ST(d18:1/h24:1) 904.62 1.020 0.098 1.034 0.115 0.919

CL(70:7) 1421.95 0.884 0.035 0.997 0.022 0.053

CL(70:6) 1423.96 0.882 0.029 0.991 0.032 0.055

CL(70:5) 1425.98 0.864 0.033 1.006 0.021 0.007

CL(70:4) 1428.00 0.862 0.032 1.000 0.039 0.045

CL(70:3) 1430.01 0.861 0.029 1.013 0.014 0.013

CL(72:9) 1445.95 0.910 0.029 1.005 0.022 0.055

CL(72:8) 1447.96 0.890 0.051 1.057 0.016 0.041

CL(72:7) 1449.98 0.755 0.043 1.035 0.015 0.006

CL(72:6) 1452.00 0.772 0.049 1.007 0.003 0.014

CL(72:5) 1454.01 0.765 0.025 1.039 0.013 0.002

CL(72:4) 1456.03 0.794 0.019 1.008 0.014 0.002

CL(72:3) 1458.04 0.874 0.017 0.994 0.008 0.006

CL(74:11) 1469.95 0.797 0.033 0.995 0.025 0.011

CL(74:10) 1471.96 0.709 0.041 0.998 0.000 0.004

CL(74:9) 1473.98 0.695 0.054 1.025 0.005 0.007

CL(74:8) 1476.00 0.650 0.043 1.048 0.038 0.004

CL(74:7) 1478.01 0.650 0.043 1.037 0.038 0.001

CL(74:6) 1480.03 0.717 0.034 1.022 0.015 0.003

CL(76:12) 1495.96 0.784 0.023 1.008 0.008 0.002

CL(76:11) 1497.98 0.684 0.030 1.009 0.013 0.002

CL(76:10) 1500.00 0.707 0.041 1.031 0.003 0.003

CL(76:9) 1502.01 0.749 0.033 1.010 0.004 0.003

CL(76:8) 1504.03 0.862 0.015 0.979 0.022 0.012

GM1(18:0) 1544.87 0.991 0.102 1.134 0.037 0.239

GM1(20:0) 1572.90 1.030 0.106 1.216 0.071 0.190

GD1(18:0)-H2O 1817.95 0.976 0.114 1.153 0.048 0.206

GD1(20:0)-H2O 1835.96 0.968 0.068 1.086 0.026 0.167

Hippocampus(c) 



 

 
Table 2: Ipsilateral/contralateral intensity ratios for various lipids species including CL’s, PI, sulfatides and gangliosides were 

assessed for the following areas noted in the optical image in Figures 1 and 2: the contusional area (a), a cortical area adjacent to 

the contusional area (b), the hippocampus (c) and the thalamus (d).  

 

Species m/z

Average CCI 

ipsilateral/ 

contralateral

Std dev CCI 

ipsilateral/ 

contralateral

Average 

naïve 

ipsilateral/ 

contralateral

Std dev naïve 

ipsilateral/ 

contralateral

p-value 

Naïve vs CCI 

(red<0.05)

ST(d18:1/18:0) 806.55 1.139 0.267 1.052 0.095 0.754

PI(38:5) 883.53 0.913 0.054 1.031 0.089 0.252

PI(38:4) 885.55 0.853 0.028 0.982 0.006 0.015

ST(d18:1/24:1) 888.62 1.019 0.335 1.032 0.217 0.971

ST(d18:1/24:0) 890.64 1.124 0.393 1.059 0.186 0.877

ST(d18:1/h24:1) 904.62 1.100 0.242 1.035 0.126 0.804

CL(70:7) 1421.95 0.955 0.075 0.998 0.019 0.584

CL(70:6) 1423.96 0.902 0.036 0.996 0.011 0.070

CL(70:5) 1425.98 0.892 0.058 0.994 0.010 0.070

CL(70:4) 1428.00 0.909 0.036 0.991 0.003 0.092

CL(70:3) 1430.01 0.886 0.037 0.985 0.030 0.094

CL(72:9) 1445.95 0.906 0.029 0.990 0.003 0.053

CL(72:8) 1447.96 0.855 0.054 1.020 0.024 0.051

CL(72:7) 1449.98 0.849 0.041 0.998 0.024 0.036

CL(72:6) 1452.00 0.829 0.004 0.980 0.009 0.000

CL(72:5) 1454.01 0.851 0.019 1.006 0.008 0.004

CL(72:4) 1456.03 0.866 0.016 0.980 0.016 0.008

CL(72:3) 1458.04 0.946 0.064 0.987 0.016 0.544

CL(74:11) 1469.95 0.753 0.065 0.984 0.004 0.030

CL(74:10) 1471.96 0.774 0.022 0.979 0.025 0.005

CL(74:9) 1473.98 0.740 0.025 0.976 0.004 0.002

CL(74:8) 1476.00 0.799 0.069 0.981 0.006 0.065

CL(74:7) 1478.01 0.799 0.069 1.021 0.065 0.030

CL(74:6) 1480.03 0.879 0.096 0.995 0.006 0.276

CL(76:12) 1495.96 0.749 0.070 0.959 0.042 0.060

CL(76:11) 1497.98 0.701 0.040 0.955 0.027 0.009

CL(76:10) 1500.00 0.718 0.053 0.973 0.014 0.014

CL(76:9) 1502.01 0.802 0.005 0.983 0.006 0.000

CL(76:8) 1504.03 0.897 0.041 0.979 0.010 0.119

GM1(18:0) 1544.87 0.988 0.089 1.111 0.148 0.438

GM1(20:0) 1572.90 0.863 0.137 1.082 0.042 0.188

GD1(18:0)-H2O 1817.95 1.005 0.113 1.105 0.147 0.550

GD1(20:0)-H2O 1835.96 0.958 0.066 1.056 0.089 0.352

Thalamus(d) 



 

Supporting Method 1: Spectra Acquisition and Data Conversion for .t2d Files on the ABI-4800 
MALDI for Tissue Imaging with full random walking 

 

Summary: This system allows MALDI-MS imaging using full random walk capabilities1 on 
an ABI 4800 instrument. Spectra are acquired with just the ABI 4000-series control 
software using a custom geometry setting and converted into an imzML data cube file 
using open source software. This data cube file can then be analyzed to generate MALDI 
images for various m/z values. This assumes that tissue sections have already been 
prepared on conductive ITO slides. This protocol requires an AB 4800 Slide Glass Guide 
for 2 pieces (Hudson Surface Technology, Old Tappan, NJ) to fit the ITO tissue slides onto 
an ABI metal base plate. The data conversion has been performed on a computer running 
Microsoft Windows 7 Enterprise 64-bit (www.windows.com) with Oracle Java runtime 
environment installed (www.java.com). 
 

OUTLINE: 

I. Spectra Acquisition on the ABI-4800 MALDI for Tissue Imaging 
a. Mark the four corners of a rectangular imaging area around the tissue slice 
b. Estimate the coordinates of the 4 corner spots 
c. Setup & load a custom plate geometry based on these coordinates 
d. Insert sample and start batch run to generate an array of t2d spectra files 

II. Data Conversion for .t2d Files 
a. Conversion of each .t2d file into an .mzXML file.  
b. All .mzXML files will be converted into an .mzML files (converter compatibility). 
c. All .mzML files will be combined into a single .imzML file. 
d. This image file can then be opened in an imzML viewer like Datacube Explorer or 

MSiReader. 
  

                                                           
1 This very involved method was developed so that full-random walk imaging could be performed on the ABI-4800 
MALDI instrument using open source software. Full random-walking within each pixel location was necessary in 
order to detect very low abundance brain cardiolipin. Higher-abundance lipids could be detected without random 
walking, and there are other open source tools that can perform imaging without random walking, such as 4000 
Series Imaging by Markus Stoeckli (available at http://maldi-msi.org ). 

http://www.windows.com/
http://www.java.com/
http://maldi-msi.org/


 

I. Spectra Acquisition on the ABI-4800 MALDI for Tissue Imaging  
 

Goal: Performing an imaging run with random walking on an ABI-4800 MALDI-TOF/TOF 
using the bundled 4000 instrument control software. 
 

The process is split into four steps: 
 

1. Mark the four corners of a rectangular imaging area around the tissue slice 
2. Estimate the coordinates of the 4 corner spots 
3. Setup & load a custom plate geometry based on these coordinates 
4. Insert sample and start batch run to generate an array of t2d spectra files 

 

1. Select the area to be imaged and mark the corners 
 

In theory any shape can be imaged on the ABI-4800 instrument, but a software limitation in one of the 
file converters limits this to a rectangular shape. More advanced shapes could be defined within a 
rectangle if the unused imaging locations are removed from the batch run prior to generating the imzML 
file (see Data Conversion section).  
 

a. Four reference marks are drawn on the ITO slide around the tissue sections as in any other 
MALDI imaging experiment. Since the illumination inside the MALDI source varies, it might 
require a dark sharpie, silver sharpie, or a white-out pen in order to best see these marks 
with the video viewer (see page 2-12 of the Applied Biosystems/MDS SCIEX 4800 MALDI 
TOF/TOF™ Analyzer Hardware Guide for adjusting the video viewer). If these marks are 
made on the back side of the ITO slide, then the alignment will be slightly off but the marker 
will not accidentally contaminate the tissue. 

 
Figure 1: Base metal plate with adapter sheets and ITO slides. Marked area for the imaging is in red ink with the 
reference marks at the four corners of the rectangles around the tissue section. 

b. The experimental slide is put into the upper slot on the plate adapter and a calibration/test 
slide in the lower slot.2 

                                                           
2 For convenience it is best to put the experimental slide in the top slot and to orient the slides so that the bottom 
of the slide (with our notations about the tissue section) is always next to the left side of the slide adapter. If the 



 

 
 

2. Get the coordinates of the four corners of the imaging area 
 

Drawing grid with x and y coordinates on the metal base plate will help make the next steps easier. The 

coordinate system that the instrument control software uses starts in the notched bottom left corner. 

The instrument’s coordinates are in µm. An estimate of the upper-left corner of the imaging area is 

needed around the tissue on the experimental side. By the way the numbers run, this is the x-minimum 

and y-maximum for the imaging area, see Figure 3 for an example. 

 

Figure 2: (left and middle) A set of slide adapter sheets, (Hudson Surface Technology, Old Tappan, NJ); (right) ABI base plate. 

a. Load the plate as any spot set, load any acquisition & analysis method and switch to manual 
control of the stage. 

b. Using the video viewer, find the upper-left reference mark that was made so that it is under 
the crosshairs of the optical camera. If the coordinate values above have been estimated, 
then they can be manually entered and the joystick can be used for fine adjustment. Make 
sure the lamp is set for best contrast so that the marks can be seen clearly (page 2-12, ABI-
4800 Hardware Guide).  

c. Using the joystick and (x,y) readout, move horizontally and vertically to find the other 
corners and make a note of the exact (x,y). Since the lateral resolution we desire in this 
present work is 200 microns, round these up to the nearest 200 microns. In this example it is 
x=58000 and y =70000. 

 

                                                           
tissue sections always go on the same general location on the ITO slides, this makes estimating the x,y coordinates 
and generating a spot set much easier. 



 

 
Figure 3: (Left) ABI base metal plate with coordinate system drawn on it for reference with a t-square and 
millimeter ruler -- the  x and y coordinates (Right) start in the bottom left corner. 

3. Create the custom plate geometry for the control software 
 

Each imaging location or “pixel” in the imaging run needs a coordinate so the instrument can perform 
the random walking within this pixel (section 3-4, ABI Getting Started Guide to the 4800). The plate 
geometry file defines for the instrument where the pixels are. Since the tissue locations are never going 
to be exactly the same size or location on the slides, each ITO slide requires a custom plate geometry 
and spot set. In this step a very fine grid is being created, similar to the well coordinate system on the 
metal plates that are commonly used on top of the metal base plates with the instrument. In this case, 
we are making a rectangular grid of pixels, each of which are 200 microns in size. The structure of the 
xml file can be seen in this example below (Template_TOP_200u.txt), where the grid for one area is 
defined. As mentioned earlier the instrument uses µm as their unit of measurement3. For convenience 
the spots on the top row are labeled from “AA01” to “AA99”, going left to right (increasing x 
coordinates). The next row down (decreasing y coordinates) is “AB01” to “AB99” and so on. Continuing 
this to the “DU” row gives a 99x99 grid of spots, each 200x200 microns in size. This covers an area of 
19.8mm x 19.8mm, which is more than enough to cover the brain sections that this method has been 
used for 
 

Template_TOP_200u.txt 
 
<TsquaredData modifiedDT="04/23/2016 15:26:32"> 

<PlateType name="TOP_SECTION" description="Plate name" width="127762" 

height="85471"> 

 

INSERT SPOT SET HERE (see example structure below in green) 

 

<Spot label="AA01" shape="E" width="200" height="200" x="58000" y="70000"/> 

.. 

<Spot label="AA99" shape="E" width="200" height="200" x="77600" y="70000"/> 

<Spot label="AB01" shape="E" width="200" height="200" x="58000" y="69800"/> 

.. 

<Spot label="AB99" shape="E" width="200" height="200" x="77600" y="69800"/> 

.. 

<Spot label="DU98" shape="E" width="200" height="200" x="77400" y="50000"/> 

<Spot label="DU99" shape="E" width="200" height="200" x="77600" y="50000"/> 

 

</PlateType> 

<SpotSetTemplate name="TOP_SECTION" description="Plate name" 

plateType="TWO_SECTION"> 

 

INSERT SPOT SET HERE ALSO 

 

</SpotSetTemplate> 

</TsquaredData> 

 
The first imaging location should have the x and y coordinates of the upper left corner of the imaging 
area (in this example it is x=58000 and y =70000). Spots AA1 to AA99 define the first row, moving 
incrementally from row AB to AC to finally DU the whole are of the grid is defined. This file can also be 
setup two contain two non-adjacent areas to be imaged, starting the second area with a spot label such 

                                                           
3 Example files of everything mentioned here, such as the auto-filling spreadsheet, are available from the authors 



 

as “MA01”, for example. The advantage of two areas is the option to queue both areas in batch mode 
and perform the runs sequentially. 
 
As typing in thousands of coordinates would be time consuming, the spot set coordinate grid for this file 
was created using a spreadsheet program (such as Microsoft Excel). A small PowerShell script could be 
used instead of a spreadsheet. A short summary of the Excel spreadsheet is below. 
 
 
 

 
a. Open a new spreadsheet file and separate the first spot label row from the 

Template_TOP_200u.txt file into multiple columns: 
 

 A B C D E F G H 

1 <Spot label=" AA 01 " shape="E" width="200" height="200" x=" 58000 " y=" 70000 "/> 

2 <Spot label=" AA 02 " shape="E" width="200" height="200" x=" =E01 +200 " y=" 70000 "/> 

2 <Spot label=" AA 03 " shape="E" width="200" height="200" x=" =E02 +200 " y=" 70000 "/> 

 
b. In cell E1 type in the upper-left x coordinate (in microns), and in G1 the upper-left y 

coordinate (in microns). If the spreadsheet is set up properly the other rows will auto-fill. 
c. Any x-values spots that are above the x-maximum (i.e. to the right of the desired imaged 

area) can be removed with the filter command in Excel (found at Data->Filter->AutoFilter) 
and y values below y-minimum (i.e. below the imaging area) can be removed by just deleting 
the last several rows. 

d. Copy all cells that contain visible values. The Excel file is no longer needed at this point, 
although saving it will make it easier to set up future imaging runs. 

e. Use Notepad (or a different text editor) to open the new plate type and spot list file 
“Template_TOP_200u.txt” and paste these spot values into both of the two locations noted. 
Excel automatically adds tabs to mark columns. To remove these, use the replace-all 
command in Notepad to replace all of the tabs with empty spaces. 

f. Choose a descriptive name for the plate type, and add this name to the two locations 
noted4. Choose a name for the spot set, and add that to the location noted. 

g. Save this as "all file types" on the drop-down menu and with a .XML extension. 
h. In the 4000 Control software, select File->XML Database Import. Import the XML file that 

was just created in the previous step. (this could take around 15 minutes depending on the 
number of spots and the instrument computer’s speed -- and this is why the HV was turned 
on several steps ago to give it a chance to warm up) 

i. Select File->New->New Spot Set. Pick names for the plate and spot set5. For the Spot Set 
template, go to the User-defined directory, and the spot set that was created previously 
should be there. 

 

4. Insert the sample and start the batch run. 
 

                                                           
4 For this present work it was "slide name_(TOP/BOT)_200u", indicating the source of the source of the tissue slice, 
whether it is the top or bottom section, and the lateral resolution (200 microns). 
5 It is easier to keep things consistent and use the same name chosen previously few steps ago. 



 

Obviously, all the instrument methods (acquisition and analysis) should be thoroughly tested before 

starting the actual imaging run (number of shoots, power, fragmentation window and settings & 

standards). Performing imaging as a batch-run of a series of spectral acquisitions allows any instrument 

method to be used for imaging, especially those with random walking. 

a. Eject the plate. Re-insert it, but using the spot set that was just defined. Give the vacuum 
and HV some time to stabilize. Give the laser a few test shots away from the imaging 
location (a second tissue slide can be loaded on the slide adapted, prepared identically, to 
test the laser). Go to the upper left corner of the imaging area to check the alignment. Since 
the video viewer is not needed during the run, turn the lamp down to 0 (saves the bulb, and 
saves the tissue from being exposed to light during a long imaging run) 

b. Hit the button to select Batch mode. Select all lines in the spot set, then right click and Copy 
Spots to Job->Using Latest Methods 

c. In the Acquisition and processing columns, select the methods that were previously 
opened/prepared. 

d. File->Validate Spot Set to check for errors 
e. Batch->Submit Spot Set Job 
f. Batch->Start Spot Set Job 
g. When the run is over, Batch->Stop Job Queue. Click the button to leave Batch mode. Select 

all lines in the batch run, then Copy Selected Items to a disk location to save the imaging run 
as a set of spectra files in T2D format. 

 

II. Data Conversion for .t2d Files 
 

Goal: Convert spectra acquired from a custom geometry plate on the ABI 4800 into an 
imzML data cube file (Strum et al, 2012), which can then be analyzed to generate images 
for various m/z values 
 

Starting situation: Folder contains .t2d spectra of every pixel as a single file. As of now 
only rectangular geometries can be converted (imzMLConverter limitation). 
 

The conversion itself is done in four steps: 

1. Conversion of each .t2d file into an .mzXML file.  
2. All .mzXML files will be converted into an .mzML files (for imzML converter compatibility). 
3. All .mzML files will be combined into a single .imzML file. 
4. This image file can then be opened in an imzML viewer like Datacube Explorer or 

MSiReader. 
 

1) Download, install and run the T2D Conveter. 
a) Written by Yu (Tom) Gao (www.pepchem.org) and uses OpenMS tools (Strum et al., 2008). 
b) Download from http://www.pepchem.org/download/converter.html 
c) Start the program, point it to the directory with the .t2d files. 

http://www.pepchem.org/
http://www.pepchem.org/download/converter.html


 

d) The converted files (.mzxml) will be generated in the same folder. 
e) Requires the current java runtime routine to be installed (www.java.com). 

 

2) Download, install and run ProteoWizard (Chambers et al., 2012). 
a) http://proteowizard.sourceforge.net/  
b) Use Windows PowerShell to convert the files via msconvert from ProteoWizard. 

i) Start Windows PowerShell or the command line (cmd)6. 
ii) Switch into the ProteoWizard directory in PowerShell or the command line (cmd) by typing 

this command:     cd 'C:\Program Files (x86)\ProteoWizard\ProteoWizard 3.0.7331' 
iii) If ProteoWizard is in a different directory (and newer version probably will be) then that 

current correct directory name will need to be used7. 
c) Use ProteoWizard to convert from .mzxml to .mzml by typing this command: 

msconvert ‘C:\your data directory \*.mzxml’ -o ‘C:\your data directory’ –v  
 

 

3) Download, install and run imzMLConverter (Race et al., 2012).  
a) http://www.cs.bham.ac.uk/~ibs/imzMLConverter/ 
b) In the Input Files tab, select the appropriate files, set the size of the image via the number of 

pixels in x and y direction, select one spectrum per file.  
c) Sometimes this program doesn’t find the files on the first try – if that happens try adding the 

files again 
d) In the Image tab, in data file content, select “MS1 spectrum” 
e) Hit “convert” and select file name for the resulting imzML datacube. 

 

4) Download, install and run MSiReader (Robichaud et al., 2013)8. 
a) http://www4.ncsu.edu/~dcmuddim/msireader.html 

i) Also install the necessary Matlab runtime environment (see MSiReader documentation). 
b) Open the final .imzML file with MSiReader. 

 

General comments: Conversion should be done on a fast Windows machine; a solid state hard drive will 

considerably speed up the conversion. The above mentioned method does not require the original .t2d 

viewer from the manufacturer on that computer. A current java runtime routine needs to be installed. 

Scripting: The paths for the windows installation should be adapted/updated accordingly, the same 

applies for the location of the data files and paths for msconvert. Windows PowerShell is a capable 

option to run scripts under windows, using its auto completion feature helps to fill out the file paths 

under Windows. It is a superior alternative to the Windows command prompt (cmd).     

                                                           
6 Windows PowerShell can be started by left-clicking on the Start Menu at the bottom-left of the desktop and 
typing “PowerShell” into the search box. There are several general guides for using PowerShell available online, 
although all that is needed to follow these directions are the two commands given above. 
7 Expert PowerShell users can save time by temporarily adding Msconvert to the path variable: 
$env:Path += ";C:\Program Files (x86)\ProteoWizard\Proteowizard 3.0.7331" 
8 Alternatively, Datacube Explorer could be used to analyze the data: 
http://www.amolf.nl/download/datacubeexplorer/ 

http://www.java.com/
http://proteowizard.sourceforge.net/
http://www.cs.bham.ac.uk/~ibs/imzMLConverter/
http://www4.ncsu.edu/~dcmuddim/msireader.html
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